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Introduzione
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Introduzione
Il Philosopher's Index è un repertorio bibliografico di filosofia, esistente anche in edizione a stampa
 (e come tale posseduto anche dalla Biblioteca dell'Istituto di filosofia della Facoltà di Scienze della formazione). 

Viene fornito insieme al prodotto su disco ottico -che è simultaneamente ed allo stesso prezzo disponibile in versione DOS, Windows e McIntosh- un manuale: User's Guide che funziona per tutte le banche dati della Dialog Corporation con software Dialog OnDisc e non solo per il Philosopher's Index. Tutte e tre le versioni hanno poi help pertinenti al contesto in cui viene richiesto aiuto. Tutte le informazioni sono in inglese. Il manuale, con moltissime illustrazioni, assomma a circa 150 pagine. I comandi per la ricerca diretta nella versione DOS sono parecchi e illustrati solo nell'help. Dalla considerazione di questi elementi è scaturita come opportuna l'idea di produrre questa breve guida che, senz'altro, non può sostituire gli estesi sussidi informativi ufficiali.

Per una compiuta presentazione di questa ed altre banche dati di filosofia su CD-ROM si veda un contributo presso il sito di E.S. Burioni Ricerche Bibliografiche: <http://www.burioni.it/cat/cd‑rom/rec/recens/00154-r.htm>.

2
Avvio
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Avvio
Avvertenza: <invio> equivale a <CR> <Enter>


Inserire il disco ottico nella sede ad hoc (drive)

•
Per attivare la versione Windows: andare col mouse sopra l'icona Dialog OnDisc e premere il pulsante di sinistra due volte

(in Windows 95, ad es.: Avvio -> Programmi -> OnDisc)

•
Per attivare la versione DOS (recarsi in DOS, in Windows 95, ad es.: Avvio -> Programmi -> Prompt MS-DOS): spostarsi sul drive del CD-ROM e dare il comando di avvio, ad es.:

C:\>d: <invio>

D:\>ondisc <invio>
3
RICERCA GUIDATA
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RICERCA GUIDATA
Ha come vantaggio quello di proporre un approccio ed uno svolgimento guidato da menu ed opzioni, descritte per esteso, senza codici di comandi, con individuazione ed esecuzione intuitive delle scelte, basate sulla posizione del cursore e click del mouse (non in DOS) o <invio>; inoltre gli indici delle voci sono visibili e percorribili. Ha come svantaggio la relativa lentezza: ogni passo va eseguito a sé e poi combinato, sviluppato etc.

In Windows tutta la ricerca è effettuabile con le opzioni di menu a tendina e di una barra con pulsanti

Windows: Search/Modify: Menu -a tendina- iniziale di ricerca con i principali canali di accesso

DOS: Easy Menu Search --> Begin a New Search --> Compare lo schermo delle search options.

3.1
Opzioni di ricerca/Search Options: canali di accesso
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Opzioni di ricerca/Search Options: canali di accesso
Sia per DOS che per Windows:

Word/Phrase Index
titolo abstract descrittori

Subject Headings (descriptors)
descrittori del thesaurus
 (anche parole interne)

Title Words
parole del titolo (apre una finestra particolare, cfr 3.2)

Author Name
nomi degli autori e curatori

Journal Name
titolo della rivista (con le abbreviazioni standard del Philosopher's Index)

Named Person
persone nominate (soggetti)

Publication Year
anno di pubblicazione

Limit Options* 
cfr. sotto

Additional Search Options** 
cfr. sotto

Use Saved Search
usare un'espressione di ricerca già salvata su disco

From Selected Display Text
usare come espressione di ricerca un frammento -marcato- di testo reperito.

Limit Options* Ulteriori opzioni: la selezione dei record è immediata

English Language Only
testi solo in inglese

Non‑English Language Only
testi solo non-in-inglese

Latest OnDisc Records Only
solo i dati dell'ultimo disco/trimestre di aggiornamento.

Additional Search Options** Ulteriori opzioni

Words & Phrases
Parole tratte da: titolo, abstract, descrittori TI/AB/DE (apre una finestra particolare, cfr. 3.2)

Language
Lingua del testo

Publisher
Editore (NB non il "curatore" ma l'ente che ha prodotto e diffuso la pubblicazione)

Document Type
monografia, articolo di rivista, contributo in monografia

Journal Announcement
numero della rivista Philosopher's Index a stampa: espresso in un numero a 3 cifre, le prime due indicano il volume, la terza il fascicolo (+ 4 sigle: CUM, RIP, RI2 TPI che riguardano blocchi particolari di record, cfr. l'help in linea)

Selezionata un'opzione, compare uno schermo in cui si possono digitare i caratteri da usare come termine di ricerca; non appena vengono scritti compare anche un indice (meno che per le parole dei titoli Title Words, per cui vedi la finestra particolare, cfr. 3.2), in maiuscolo, che si sposta in ragione di quanto scriviamo (tale alphabetic scrolling è completo, anche retrocedente). Ogni termine selezionato viene evidenziato, sulla destra è indicato il numero dei riferimenti bibliografici collegati. 

Sia in Windows che in DOS, più voci selezionate vengono automaticamente collegate in OR logico (somma, allargamento), <invio> alla fine della selezione.

In Windows si lavora col mouse per selezionare e spostarsi, e coi bottoni di OK, Cancel, Help. 

In DOS, un basso una striscia (barra) rappresenta il menu dei comandi disponibili: è importante leggere quanto indicato ed imparare progressivamente l'uso del programma proprio sulla scorta di quanto compare a video: 

<F1>
qui e dovunque— richiama uno schermo di help contestuale, legato cioè alla circostanza in cui viene richiamato

Cursore
su/giù serve a spostarsi lungo l'elenco (Pg su e  giù agiscono similmente)

<invio>
per de/selezionare le voci su cui ci si trova posizionati

<F10>
per concludere ed avviare la ricerca completa

Ad ogni click del mouse o <invio> viene marcato con un asterisco il termine scelto (fino ad un massimo di 50) e viene svolta una ricerca —parziale e progressivamente cumulativa— il cui risultato è mostrato in basso a destra. E' utile selezionare più termini per raggruppare varianti ortografiche (anche errate), radici di parole...

Viene automaticamente mostrato il risultato: in Windows i record reperiti, in DOS compare un messaggio del tipo:

                    Philosopher's Index 1940 - September 1996

1   460 Records with Subject Headings of VIOLENCE or VIRGIN or VIRILITY
con, in basso:

"Select Main Activity"

1
Display, Print or Transfer the Selected Record(s)
Visualizza su stampa, carta o disco

2
Modify the current search with additional criteria
Raffinare, elaborare la ricerca

3
Begin a New Search (clears existing search)
La ricerca riparte da zero

4
Save Search Strategy for Later Use
Salvare la ricerca eseguita (strategy) per un uso futuro

5
Quit Easy Menu Mode
Abbandonare la ricerca guidata
Per muoversi nell'elenco: o Prev Next; oppure, sull'elenco dei titoli —che compaiono uno per riga quando si è selezionato questo modo nel menu Display— ci si muove con il mouse.

3.2
F - Full text search: finestra particolare per ricerca sull'indice delle parole
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F - Full text search: finestra particolare per ricerca sull'indice delle parole
E' uno scampolo di ricerca simile a quella diretta a comandi, cfr. 4 a p. 4 e ss. 

La prima opzione: Search Options -> Word/Phrase Index verte sul solo indice dei titoli.

La seconda opzione: Additional Search Options -> Words & Phrases verte su un indice misto di parole tratte da titolo, abstract e descrittori a soggetto. 

Si ha di fronte uno schermo con tre caselle. Si possono scrivere fino a tre elementi (singole parole o "frasi") uno per casella. 

E' sempre ammesso il troncamento di una radice di lemma, a destra, con il punto interrogativo ?. 

Non vanno usate come termini di ricerca le cosiddette parole vuote (stopwords, cfr. 4 a p. 5), i segni di punteggiatura, ed altre "parole comuni" non determinanti per la ricerca.

I contenuti delle diverse caselle verranno comunque posti in legame di O logico fra di essi.

Una frase può contenere parole collegate da questi operatori.

blank
termini adiacenti e nell'ordine indicato: "free will" (massimo rafforzamento dello E logico)

.
termini separati da massimo una parola, e nell'ordine indicato: analisi.categorie

...
similmente termini separati da massimo tre parole 

_
similmente termini presenti nello stesso paragrafo dello stesso campo (titolo abstract descrittori a soggetto): homunculus_veritas

*
similmente termini compresenti nello stesso campo, uniti da E logico, in qualsiasi ordine: TIME*IDENTI?

3.3
Visualizzazione dei record: opzione Display
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Visualizzazione dei record: opzione Display
Ci sono vari formati di visualizzazione dei record:

Display Format Options
Complete Record

List of Titles

Bibliographic Reference

Key Word in Context

User‑Defined Format, con ulteriore selezione dei campi e TAG da usare per visulizzazione, stampa, esportazione

Cfr. oltre FORMAT a p. 6 in 4 RICERCA A COMANDI DIRETTI per una illustrazione delle loro caratteristiche.

In Windows il formato scelto per visualizzare è quello che verrà eventualmente assunto come Standard nell'esportazione dei documenti su disco.

3.4
Continuare e elaborare una ricerca
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Continuare e elaborare una ricerca
Eseguita un'espressione di ricerca, un successivo analogo comando di ricerca propone di considerare anche la precedente, per integrarla (con intersezione, allargamento ...), rimpiazzarla etc.

In Windows fatta una ricerca, mostratone l'esito, se si riattiva "Search/Modify" e, normalmente, si sceglie un canale di accesso, compare la finestra "Modify Search", a meno che non si tenga premuto il tasto <Ctrl> mentre si seleziona "Search/Modify"

In DOS si sceglie l'opzione: Modify Existing Search.

E' la strada obbligata se, utilizzando la ricerca guidata, si vogliono combinare termini in modo diverso dall'OR (a parte l'opzione F - Full text search, cfr. 3.2).

In Windows una ricerca ex-novo viene indicata come "New Search".

In Windows chiede anche se la nuova ricerca deve essere considerata nuova pur conservando la precedente strategia -percorso- di ricerca: "Add set".

Se si vuole elaborare la ricerca corrente: "Modify", lo schermo/menu offre le opzioni:

AND
limitare con altri termini (E logico: intersezione, restrittiva)

OR
aggiungere altri termini come alternativa (O logico: somma, espansiva)

NOT
escludere termini (NON logico: esclusione, restrittiva)

Windows consente anche di limitare la combinazione, oltre che allo stesso documento (default di scelta), allo stesso campo o sottocampo.

In DOS vari comandi —per stampa, salvataggio su disco, ordinamento, marcamento— sono offerti solo quando si è in visualizzazione dei record, di uno o più.

3.5
Stampare ed esportare record
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Stampare su carta o su disco, in Windows dal menu File, scegliere Print documents, in DOS la possibilità compare dopo la visualizzazione dei record.

— In Windows compare una finestra in cui si possono impostare molti valori: il Setup della stampante, selezionare il livello di qualità grafica, la stampa di più copie, quali record stampare (Which documents):

Solo quello mostrato sullo schermo - Current only

Tutti - All

Solo la fascia selezionata - From:    to:

Solo quelli marcati (NB bisogna averne marcati)

Se stampare come file su disco invece che sulla stampante (Windows chiederà poi nome e percorso per il file da creare)

Se stampare un solo documento per pagine, un contatore (nella forma "n of N" 
come intestazione, la strategia (storia) della ricerca all'inizio.

(non sembra funzionare la stampa di un solo blocco di testo selezionato, non serve a ciò l'opzione -mostrata nella parte alta- "Print Range" che ha sempre valore All e comunque condizionato alle scelte sottostanti; pertanto si ricorrerà al lavoro sui blocchi di testo coi comandi standard di Windows: marcare, Ctrl-C, andare nell'ambiente di scrittura e <Ctrl-V>)

— In DOS: <F8> Print

Sistemare le Opzioni, se è il caso, e poi stampare PRINT o scrivere -esportare- su disco TRANSFER:

PRINT Currently Displayed Record Only: stampa solo il record ora mostrato

PRINT All n Selected Records: stampa tutto l'esito della ricerca

PRINT Marked Records Only: stampa solo i record precedentemente marcati con <F7>

TRANSFER Current Record Only to Disk: scrivere/stampare su disco solo il record ora mostrato

TRANSFER All Selected Records to Disk: scrivere/stampare su disco tutto l'esito della ricerca

TRANSFER Marked Records Only to Disk: scrivere/stampare su disco solo i record precedentemente marcati con <F7>

Altre opzioni di stampa vengono offerte anzitutto con un valore già assunto, per default, e comunque alterabile:

Lines per page:
numero di righe per ogni pagina

Page Break for Each Record:
salto a nuova pagina dopo ciascun record; anche in Windows
Transfer File Format:
DISPLAY - formato in cui scrivere i record

Include Search History:
se stampare anche il percorso di ricerca seguito; anche in Windows
Page Numbers:
numerare le pagine

Formato per scegliere il formato dei record da stampare o trasferire: DOS F4 Format, cfr. 3.3.

La funzione di "TRANSFER" in DOS e di "Save documents as" nel menu File di Windows serve ad esportare record su disco, per riutilizzarli sia come mero testo con un word processor sia come record all'interno di una programma per gestire dati bibliografici come ProCite. Il formato quanto a contenuto dei record è quello assunto o definito in Display.

In Windows formati per il trasferimento, esportazione, dei record includono opzioni non previste per la stampa e funzionali, appunto, al caricamento successivo dei record in un programma per database:

Standard
il formato usato in quel momento per la visualizzazione

Tagged
ogni campo è preceduto da un etichetta di due lettere sulla sinistra, è il formato ormai più corrente nelle banche dati bibliografiche per visualizzazione ed esportazione. Un software come ProCite può importarli e trasformarli in record

CSV
comma separated values o anche comma delimited, ogni campo è delimitato da una coppia di doppie virgolette e separato dall'altro tramite virgola: "Author: ","Miccolis, Stefano"

Tabbed
come sopra, CSV, però qui il separatore è il tabulatore e non la virgola

Fixed
usa spazi per separare i campi

In Windows l'operazione di trasferimento permette anche di indicare se il file comincerà con l'intestazione raffigurante la strategia di ricerca seguita, se l'output si accoderà (append) a un file già esistente, quali documenti (corrente, tutti, fascia, i marcati) esportare.

3.6
Ordinamento/Sort 
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Ordinamento/Sort 
Si possono ordinare i documenti -record- reperiti. Le opzioni di ordinamento, che potranno essere alfanumericamente ascendenti o discendenti sono: titolo (Title), nome di autore (Author Name), titolo -abbreviato- di rivista (Journal Name), anno di pubblicazione (Publication Year), frequenza nel campo specificato, nei record reperiti, del termine usato per la ricerca (Frequency of Search Terms).

In Windows: menu Sort.

In DOS: <F5> compare dopo la scelta dell'opzione di visualizzazione dei record.

3.7
Marcare i record
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Marcare i record
In Windows, mentre vengono visualizzati i record, una casella in basso "Marked" offre la possibilità di selezionare singolarmente i record col mouse.

In DOS compare dopo la scelta dell'opzione di visualizzazione dei record: il comando <F7>, che quantunque sempre mostrato, non è sempre attivo. <F7> non può agire su una lista (infatti: beep), ma su un singolo record che occupa tutto il display.

Per muoversi nell'elenco: o <Shift‑F7> direttamente e poi si scrive il numero, oppure <F10> e <Shift‑F7> più il numero.

3.8
Salvare una espressione di ricerca e rieseguirla
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Salvare una espressione di ricerca e rieseguirla
Una volta eseguita una ricerca, anche complessa, fatta di molti passi, se ne può salvare in un file di testo l'espressione formalizzata, in modo da poterla rieseguire automaticamente senza dovere scrivere nulla, ma solo richiamandola tramite il nome di file.

In Windows dal menu File selezionare Save search strategy e poi dare nome ed eventuale percorso. Per rieseguirla, dal menu Search/Modify selezionare Use saved search.

In DOS, eseguita una ricerca, su Select main activity, selezionare Save Search Strategy for Later Use ed indicare il nome. Per rieseguirla, dal menu Search Options selezionare Use saved search.

3.9
Cercare con qualcosa di trovato
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Cercare con qualcosa di trovato
Utilizzare parte di ciò che compare sullo schermo come termine di ricerca, in Windows: marcare testo con il mouse, dal menu Search/Modify -> From selected display text, lo usa automaticamente come termine di ricerca, In DOS: <F10> e poi <F6>, segnare con il cursore l'inizio e poi selezionare con la barra spaziatrice parole in sequenza, dopodiché "Use selected text to:" e ricomincia come in 3.4 Elaborare una ricerca.

4
RICERCA A COMANDI DIRETTI
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RICERCA A COMANDI DIRETTI
E' un tipo di ricerca con comandi ed espressioni composte su una linea, come la "Dialog searching on-line" ricerca in linea nei database della Dialog. Simile a quella fattibile con altri augusti linguaggi del genere, è più potente e diretta di quella guidata, richiede una formalizzazione delle espressioni ed il rispetto di regole.

In Windows, viene mostrata con scelta del menu Window -> Tile horizontally e compare la finestra, inferiore, della Search history -> in cui ci si sposta col mouse, e poi click del mouse nel quadratino con Show/Use Dialog Commands (volendo click anche su Include Postings per vedere le occorrenze, nei documenti, dei termini cercati e non solo il totale dei documenti reperiti tramite essi, inferiore).

In Windows molti comandi diretti (es.: DISPLAY -se da solo-, TYPE, SAVE, RECALL, PRINT...) mancano -non vengono riconosciuti e segnalati solo come "Invalid command TYPE ? for info on commands"- perché si può sempre ricorrere ai contestuali menu a tendina della, superiore, finestra di ricerca, guidata.

In DOS dal menu iniziale scegliere: "DIALOG Command Search" invece di "Easy menu Search", a cui si può sempre ricorrere, durante le operazioni, con <F2>.

4.1
Cercare
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Cercare
Un'espressione di ricerca viene identificata dal punto interrogativo iniziale, affisso dal programma, e si apre con il comando SELECT, quindi scrivere: Select o S come valida abbreviazione.

E' ammesso il troncamento a destra col punto interrogativo: ? 

SELECT (LASER? OR OPTIC?)(W)(DISC? OR DISK?)

Evitare punteggiatura e stopwords (parole non significative) come:  a, an, and, are, as, by, for, from, in, of, on, that, the, this, to, with, would, whether...

Si possono cercare contemporaneamente più parole con operatori:

-NON logico: NOT

-O logico: OR

-E logico: AND oppure * asterisco, 

W per within: separati da tre parole o meno, nella sequenza indicata: SYMBOL?(3w)LOGIC?

N per next -fra parentesi- come operatori di prossimità: separati da tre parole o meno, nella sequenza indicata o inversa SYMBOL?(3n)LOGIC?

adiacenti e nella sequenza indicata: SYMBOLIC LOGIC (ricerca per frase)

Operatori relazionali (dove hanno senso), es.: PY>=1994, opere pubblicate nel 1994 e successivamente

S PY=(1990 OR 1991 OR 1992)

S PY=(1990 OR 1991 OR 1992) AND PY<=1997

Si possono usare le parentesi per fraseggiare, vedi oltre.

In Windows cliccare su linee precedenti fa rieseguire la ricerca.

4.1.1
Limitare la ricerca dei termini a determinati campi
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Limitare la ricerca dei termini a determinati campi
Se non vengono indicati campi, la ricerca vale automaticamente per il "Words Index" cioè AB abstract TI titolo DE soggetti

I campi principali, vengono specificati come suffisso in questo modo:

esempio
/AB  Abstract:
S UNIVERSAL(W)LAW/AB

/DE  Descriptor:
S ETHICS/DE

/TI  Title:
S CATEGORICAL(W)IMPERATIVE/TI

Altri campi, si specificano come prefisso:

AN= DIALOG Accession Number
S AN=052017

AU= Author
S AU=POTTER JR, N?

DT= Document Type
S DT=MONOGRAPH

JA= Journal Announcement
S JA=105

JN= Journal Name (NB Abbreviato)
S JN=PHILOSOPHIA (ISR?

LA= Language
S LA=SPANISH

NA= Named Person
S NA=KANT  (NB gli autori "celebri" vanno in indice senza prenome)

PU= Publisher
S PU=ANCHOR

PY= Publication Year
S PY>=1985 

UD= Update
S UD=9999

4.2
Ordinamento/Sort
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Ordinamento/Sort
Campi su cui si può fare l'ordinamento (SORTable Fields) sono: AU, JN, PY, TI. Si può indicare anche se l'ordine deve essere discendente, con D, o ascendente, con A, (assunto per default)

SORT S3/ALL/JN  ordina (SORT) il risultato della ricerca n. 3 (S3), tutti i record (ALL), in base al titolo della rivista (JN)

SORT S5/ALL/PY,D ... idem in base all'anno di pubblicazione e in ordine decrescente (D)

4.3
Visualizzare l'esito della ricerca
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Visualizzare l'esito della ricerca
Per visualizzare l'esito della ricerca e, volendo, indicare anche direttamente che formato usare, tramite la specificazione dei nomi dei campi (cfr. TYPE a p. 8):

    TYPE S2/TI,JN/1‑3 = mostra l'esito della ricerca n. 2 (TYPE S2), facendo vedere solo i campi del titolo (TI) e della rivista (JN) (si scandisce con la virgola), dei record dall'1 al 3 (1-3)

4.4
Stampare su disco
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Stampare su disco
Per stampare su disco l'esito di una ricerca già eseguita, magari selezionando solo alcuni record, eseguire la ricerca, se si tratta di un passo precedente, lo si può:

-rivedere con DS, 

-rieseguire con S Sn, 

-poi SET PRINT A:nomefile, 

-PRINT set/formato/numeri record (cfr. in 4 TYPE e FORMAT per le opzioni).

4.5
Aiuto/Help
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Aiuto/Help
Si scrive Help così, oppure seguito dal nome di un comando su cui si richiedono informazioni.

4.6
COMANDI, sommario alfabetico
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COMANDI, sommario alfabetico
Comando fondamentale per iniziare una ricerca è SELECT abbreviabile in S.

BEGIN Chiude la ricerca in atto e comincia una nuova sessione di ricerca, serve anche a "ripulire" per partire da 0 con una strategia mirata poi da salvare

DISPLAY (non in Windows), (o D) mostra i record della ricerca, uno per schermo (mentre il quasi identico TYPE può mostrarne più di uno per schermo):

DISPLAY S1/5/1‑5     dove S1 è il risultato del passo di ricerca numerato 1 e il 5 indica il tipo di formato (cfr. sotto FORMAT);

DS (o DSP) DISPLAY SETS, da solo, per rivedere i passi compiuti nella ricerca in corso: utile per poi rieseguire un passo con SELECT: S S3; DSP per stampare la search history, il percorso delle ricerche fatte.

EXECUTE STEPS (o EXS) (non in Windows). Esegue un'intera strategia di ricerca precedentemente salvata su disco (saved search): nome della ricerca salvata, drive incluso

EXPAND (non in Windows), (o E) con una parola o una radice senza troncamento, visualizza l'indice generale (tutto, incluso AB,TI,DE, anche se si indica solo DE=)

EXPAND BIOL

Viene mostrata una sezione dell'indice con i termini numerati come En. Questi saranno richiamabili come tali in SELECT, anche a gruppi, S E4:E12

Per mostrare la sezione di un indice particolare, se ne indicherà il prefisso:

EXPAND AU=SMITH

Si può scorrere con PgDn p, con "p" come abbreviazione di PAGE. E' utile perché introduce nel modo "a comandi" un approccio del modo guidato a menu.

FORMAT (non in Windows). Selezionare un formato: indicarlo col numero, cfr. qui sotto Formati predefiniti. HELP FORMAT ne dà una lista. 

Si può definire un formato personalizzato, facendo direttamente l'elenco dei campi che si desidera vedere comparire. Separare più campi con la virgola: 

TYPE S1/TI,AB/1‑5

-oppure con H (Hits), mostra automaticamente solo i campi che hanno soddisfatto l'espressione di ricerca: TYPE S1/H/1‑5

-oppure con K (KWIC):  TYPE S1/K/1‑5 formato key words in context
-oppure con T (Titles):  TYPE S2/T/ALL solo i titoli

Formati predefiniti: in DOS 11 + 1 (quello coi TAG)

NUMERO
CONTENUTO MOSTRATO
Format 1
DIALOG Accession Number (non in Windows)

Format 2
Tutto il record meno l'Abstract (non in Windows)

Format 3
Citazione bibliografica (Bibliographic reference)

Format 4
Abstract e titolo (non in Windows)

Format 5
Record completo (Complete)

Format 6
Titolo (List of Titles)

Format 7
Citazione bibliografica con Abstract (non in Windows)

Format 8
Titolo e Indexing (ossia descrittori a soggetto e Named people) (non in Windows)

Format H
Solo i campi che contengono i termini usati per la ricerca (o "hits") (non in Windows)

Format K
KWIC (Key Word In Context): i termini usati e reperiti, nel campo in cui comparivano, come contesto

Format T
Solo l'elenco dei titoli

Si possono anche comporre formati diversi al momento, indicando dei campi tramite la loro etichetta: TYPE S1/DE,H/1‑3,5 significa: "mostra l'esito della ricerca n. 1, coi soli campi descrittori e quelli previsti dal formato H, prendi i record 1,2,3 e 5".

HELP (non in Windows, lì il "?" sulla linea dei comandi avvia l'help contestuale, es.: ?? SELECT)

HELP FILE descrizione del database in uso

HELP FIELD illustrazione dei campi disponibili

HELP FORMAT illustra i formati disponibili coi comandi TYPE, DISPLAY, and PRINT

HELP KEYBOARD impostazione della tastiera, comandi, tasti funzione

HELP LIMIT dà indicazioni su quali sono le limitazioni utilizzabili (AB DE DT TI, anno, lingua: ENG o NONENG)

HELP ONLINE come passare un'espressione di ricerca da DIALOG OnDisc a DIALOG online

HELP STOPWORD elenco delle stopword in uso nel database

HELP THESAURUS dà informazioni sul soggettario strutturato come Thesaurus, quando c'è.

KEEP (non in Windows) memorizza dei record nell'insieme S0. S0 può poi essere sottoposto a SORT, TYPE, DISPLAY, o PRINT, ed incluso in SELECT.

KEEP può riguardare record specifici o gruppi di records

    KEEP S3
tutto l'insieme 3 va in S0

    K S3/1,4,6‑8
i record 1,4,6,7,8 vanno in S0

    K /1‑5
i record da 1 a 5 dell'insieme precedente vanno in S0

    KEEP‑
svuota S0

LIMITALL (non in Windows) imposta dei limiti che entrano e rimangono in vigore durante le successive operazioni di ricerca:

      LIMITALL/AB,ENG

Con questo comando, automaticamente, tutte le ricerche successive verranno limitate al campo abstract ed ai documenti in inglese (vale come un AND preventivo generale). Per riazzerare: LIMITALL CANCEL.

PRINT (non in Windows) stampare. Per stampare su disco come file, dare prima il comando SET PRINT [percorso]nome file: per i parametri (set, formato campi, num. record) cfr. TYPE

RECALL (non in Windows) per richiamare, visualizzandole e non eseguendole, ricerche salvate: ossia espressioni di ricerca accantonate su disco come file. Essendo file, se è il caso ne va dato il path, l'indirizzo su disco.

RECALL SAVES
Mostra tutte le ricerche salvate nel drive di default

RECALL A:SAVES
idem in A:

RECALL DEMO1
idem come file DEMO1

RECALL A:DEMO1
file DEMO1 nel disco del drive A:

RELEASE (non in Windows) per cancellare ricerche salvate

RELEASE LEGAL1

RELEASE A:LEGAL2

non c'è bisogno di indicare l'estensione .SRC

REPORT (non in Windows) visualizza a mo' di report: colonne in tabella

SAVE (non in Windows) Salva tutti i passi di una ricerca come file, per poterla riutilizzare con EXECUTE

SAVE LEGAL1

SAVE A:LEGAL2

sono file con estensione. SRC. 

Per essere sicuri di salvare una strategia pulita, con i soli passi che ci interessano, occorre riazzerare quanto eventualmente fatto e creare operativamente quella che si intende preservare, poi salvarla. Naturalmente una strategia può anche essere composta di un solo passo di ricerca. Per eliminare alcuni passi successivi a quello da salvaguardare cfr. 4.7.

SCORRERE L'ELENCO dei record. Dopo i comandi TYPE o DISPLAY compare il primo record della lista

      PgDn
Schermo o record successivo

      Ctrl+PgDn
Record successivo

      PgUp
Schermo precedente dello stesso record

      Ctrl+PgUp
Record precedente

      Home
Primo schermo del record in esame

      Ctrl+Home
Primo record dell'insieme

       arrow
Una riga in su

       arrow
Una riga giù

      Ctrl+N
Salta al prossimo termine di ricerca trovato nel record corrente (NB highlighting, evidenziazione)

SELECT (o S) comando fondamentale per ogni ricerca; quando usato senza delimitatore di campo vale per Words Index (AB TI DE)

SELECT STEPS (o SS) crea un risultato distinto per ogni termine indicato, es.:

SELECT LASER

S JN=PSYCHOLOGY TODAY    cerca tutti i record  degli articoli pubblicati nella rivista "Psychology today"

Si richiamano passaggi precedenti con il loro numero di sequenza S S1 OR S7

Quando si dà l'EXPAND (es.: EXPAND AU=CIMM?) i termini dell'indice vengono numerati, SELECT (E2 OR E4:E6) AND S1. SELECT può quindi richiamare termini numerati come En. Usare l'operatore OR o i due punti per indicare una sequenza.

Operatori logici:
S OIL OR GAS
recupera record con oil o gas

S OIL AND GAS
recupera record con oil e gas

S OIL NOT GAS
recupera record con oil ma non gas

Operatori di adiacenza: (restrizione dello E logico)

SELECT HORSE (W) RACING
recupera record con sia horse che racing adiacenti l'uno all'altro nell'ordine indicato

SELECT HORSE (5W) RACING
recupera record con horse e racing, dove racing è presente a non più di 5 parole di distanza (stopword incluse) dopo horse

SELECT HORSE (5N) RACING
come sopra, ma qui racing può anche stare prima di horse

SELECT HORSE (S) RACING
recupera record con sia horse che racing nella stessa frase

SELECT WILL(L)FREE
recupera record con will e free facenti parte del medesimo descrittore (FREE WILL)

Parentesi Quando ci sono più operatori, si impone una scansione per l'ordine di esecuzione con le parentesi:

     SELECT (LASER OR OPTICAL OR VIDEO)(W)(DISC OR DISK)

SET cambiare le impostazioni per postings on/off per stampante o file su disco come output. In Windows è offerta una casella ad hoc "Include postings" nella finestra Search History

SORT Per ordinare i record che costituiscono il risultato di una ricerca. Il comando ha tre parametri: il numero del set -passo di ricerca- da ordinare, quali record (ALL per tutti), quali campi assumere come chiavi di ordinamento. Si può indicare un ordine de/crescente dei record.

Il comando qui sotto mostrato ordina tutto il risultato della prima ricerca, facendo comparire solo il contenuto dei campi autore ed anno di pubblicazione, in ordine decrescente:

      SORT S1/ALL/AU/PY,D

I record possono venire anche ordinati in base alla frequenza con cui i termini di ricerca utilizzati ricorrono nei record (frequenza di posting), si usa il codice PO:

      SORT S1/ALL/PO

Mentre si visualizzano record ci sono comunque opzioni guidate per sort, scelta del formato, marcamento, stampa etc. -come nella ricerca guidata.

STOPWORDS  Parole non ricercabili, ma da contare quando si usano operatori di prossimità: a ("A" maiuscola non è una stopword) ARE FOR OF THE WITH AN AS FROM ON THIS WOULD AND BY IN THAT TO
Es.: "...defence of Rorty's Pragmatism" include la stopword OF: per usare l'operatore (W) occorre indicare la tolleranza di una parola:  S defence(1W)rorty, laddove S defence(W)rorty dà esito nullo

TAG nei comandi TYPE e DISPLAY impone il nome ai campi come etichette di due lettere sulla sinistra (importante per riprendere i record scritti su disco in programmi come ProCite)

       TYPE S1/5/1‑10 TAG

NOTAG ripristina il display format standard

TASTIERA (DOS)

F1
HELP

F2
"Easy Menu Search"

F3
richiama il precedente comando di linea

Ctrl+Break
blocca una ricerca (SELECT) in corso

 arrow
una linea giù nel Display

 arrow
una linea su nel Display

PgDn (page down)
schermo successivo del record in esame 

PgUp (page up)
schermo precedente del record in esame

Ctrl+PgDn
al primo schermo del record successivo

Ctrl+PgUp
al primo schermo del record precedente

Home
al primo schermo del record in esame

Ctrl+Home
al primo schermo del primo record

TYPE (non in Windows), (o T) per visualizzare i record reperiti. Si può specificare l'esito di un passo precedente:

T S2

Si può, inoltre, specificare il formato di visualizzazione, quali record vedere, e se si devono mostrare i TAG (etichette) come nomi di campo:

TYPE S3/6/2‑5

significa: mostra il risultato della ricerca/set 3 (se viene omesso S3, viene automaticamente assunto l'ultimo) nel formato n. 6 -cfr. il comando FORMAT- (se omesso vale il n. 2), visualizzando solo i record da 2 a 5.

4.7
Raffinare un risultato di ricerca: Delete search steps 
Dal momento che
 il Menu mode progredisce, raffina, solo sulla base dell'ultima ricerca, per riprenderne una già fatta e limitarla/espanderla si eliminano le altre che la seguono, dimodoché quella voluta venga enucleata come unica: il comando chiede infatti, non quale distruggere, ma quale conservare come ultima. Indicato l'ultimo step/livello da tenere, i successivi vengono fatti sparire, l'ultimo vale per raffinare la ricerca a partire da esso. Il comando BEGIN riazzera, distruggendo tutti i passi.

�The philosopher's index : an international index to philosophical periodicals and books. - [1967]- . - Bowling Green (Ohio) : Philosophy Documentation Centre. Bowling Green State University, [1967?]-  . Trimestrale. — Descrizione basata su: 20(1986).


�Qui si consulta all'interno dell'indice: la stessa opzione tratta da Additional Search Options consente -sia in DOS che in Windows- scrittura di più termini congiunti con operatori di adiacenza, prossimità, compresenza nel campo, troncamento, così anche Title words, cfr. oltre 3.2 F - Full text search.


�The Philosopher's Index thesaurus / Richard H. Lineback, editor ; Lynn Walkiewicz, assistant editor. - Bowling Green (Ohio) : Philosophy Documentation Centre. Bowling Green State University, 1992. - 112 p.


�C'è anche ben altro in aggiunta a nomi delle persone nominate: disordine o descrittori minori, o eccedenti.





�


 �a differenza del Command mode, vedi oltre RICERCA A COMANDI DIRETTI�





